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Introduction
The Full Bucket Vocoder FBVC is a software plug-in for Microsoft Windows 
(VST2/VST3) and Apple macOS (VST2/VST3/AU) simulating the classic KORG® VC-10 
Vocoder from 1978. It is written in native C++ code for high performance and low 
CPU consumption. The main features are:

● 20 band full stereo vocoder
● 64 voice polyphonic built-in Tone Generator section
● Accent Bending and Vibrato effects
● Optional WAV file playback
● Fully tweakable Analysis/Synthesis section
● Tweakable Ensemble effect
● Double precision audio processing
● All parameters can be controlled by MIDI controllers
● Plug-in supports Windows and macOS (32 bit and 64 bit)

FBVC is based on the new iPlug2 framework maintained by Oli Larkin and the 
iPlug2 team. Big thanks, guys!!! Without your work it would not have been possible 
to create a resizable FBVC user interface.

To resize the plug-in you just grab the yellow triangle at the bottom right of the FBVC 
window and drag it. You can save the current window size using the menu entry  
“Save Window Size” in the Options Menu.

If you have trouble with the standard version of FBVC, please grab the (sound-wise 
identical) “N” version of the plug-in which is based on the original iPlug framework.

The Voice of the Past

Once upon a time I promised myself not to create a simulation of an existing piece of 
hardware that I do not own by myself. Well, as you can see, I broke my promise 
again: I never owned a VC-10 nor is it very likely that I ever will. Hey, sounds like the 
introduction to my Nabla and Stigma synthesizers! ;-)

In 1978, KORG presented the VC-10 Vocoder. This neat little instrument was 
packaged in a MS-10 housing plus goose-neck microphone and keyboard that allowed 
for instant vocoding experience without attaching any other gear. The integrated Tone 
Generator was “fully polyphonic” (meaning that each key produced an individual 
Sawtooth wave), could be mixed with an additional White Noise source, and served as 
the Carrier signal, while the microphone input provided the Modulator signal. Of 
course it was possible to replace both Carrier and Modulator with external signal 
sources.

The VC-10 also offered some more cool effects like Accent Bend (where the level of 
the Modulator signal “bends” the pitch of the Tone Generator) and Vibrato for the Tone 
Generator, as well as Ensemble (known from the PS-3100/3200 and the Delta). But it 
also had some drawbacks like a missing voiced/unvoiced detector and even potential 
design flaws -  for example the highest four filters of the vocoder section were only 
fed with the noise signal). But despite of these disadvantages the VC-10 was a 
fantastic instrument and well worth being recreated in software.
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The Voice of Today

When creating the FBVC I took some liberty in that I added/changed the following 
features which cannot be found in the original VC-10:

● Full stereo operation
● 64 voice polyphonic Tone Generator supporting all MIDI note values (not only 

the 32 keys plus one octave)
● Velocity control for the Tone Generator
● Modulator signal can be replaced by mono/stereo WAV file playback

● Mode can be switched from “Standard” to the “Full Band” mode (where the 
signal of the Tone Generator is fed into all 20 bands)

● Tweak section:
• Adjustable frequencies of all Analysis and Synthesis bands
• Adjustable levels of all Synthesis bands
• All Analysis and Synthesis bands can be switched to fixed levels
• Bias and Limit for filter output VCAs
• Attack and Release for Tone Generators
• Adjustable LFO rates for Ensemble effect

● Not to forget: 64 presets and MIDI CC support!

The architecture of the FBVC is visualized by the following block diagram on the front 
panel.

Architecture of the FBVC

So how does it work? The microphone input signal (well, any signal you feed into the 
first two inputs of the FBVC…) is used as the Modulator signal, i.e. it is analyzed by 20 
bandpass filters and their responses are converted into 20 control signals. The Tone 
Generator signal mixed with the Noise and the external signal (any signal you feed 
into inputs 3 and 4 of the FBVC) serves as the Carrier signal: It is filtered by another 
bunch of 20 bandpass filters and their level is controlled in real-time by the control 
signals of the Modulator. These filtered carrier signals, summed-up and optionally 
send to the Ensemble effect, provide the output signal. Magic.



Full Bucket Vocoder FBVC Manual Page 5
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Basic Operation
Although the panel of the VC-10 (and thus the panel of the FBVC) is laid out neatly, it 
is at the same time a bit cluttered. Let’s get the pieces together!

The Microphone Section (MIC)

The Microphone section stands as a synonym for anything concerning the Modulator 
signal. It has only one control, namely the “MIC LEVEL” knob that controls the input 
volume.

Being a software plug-in, the FBVC of course does not have a real microphone. In fact 
the latter refers to the first two inputs, “MIC Left” and “MIC Right”.

The Tone Generator Section

The Tone Generator produces the internal signals for the Carrier. It can be mixed with 
a White Noise signal via the “IN BALANCE” knob and shifted one octave up using the 
“OCTAVE” switch. Fine tuning is done by the “TUNE” knob, and three (!) independent 
LFOs provide a Vibrato effect with adjustable “SPEED” and “DEPTH”. 

“ACCENT BEND” bends the pitch of the Tone Generator with respect to the level of the 
analyzed Modulator signal. This is a pretty spooky effect – according to the original 
Owner’s Manual of the VC-10 it “adds a slight pitch wavering effect so that the sound 
produced is more like a real human voice”. Try it yourself.

“PITCH BEND” controls the amount of Pitch Bending of the Tone Generator (± 12 
notes). Finally, the “VELOCITY” knob controls the amount of velocity applied to the 
volume of a played key. Note that the original VC-10 was not sensitive to velocity.
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The External Section (EXT)

In parallel to the Tone Generator, you can use an external signal plugged into inputs 3 
(“EXT Left”) and 4 (“EXT Right”) of the FBVC plug-in as a Carrier signal. The volume 
of this signal is controlled by the “EXT LEVEL” knob.

The VU Meter

Like the VC-10, the FBVC offers a VU meter to check the levels of the Carrier or 
Modulator signals. Note that the VU meter is an analog device – the readout values 
may differ a little bit from the exact level values.

Ensemble and Output Section

The Ensemble effect can be activated using the “ENSEMBLE” switch, and the “OUT 
BALANCE” knob controls the mix between Vocoder and Microphone (input) signal sent 
to the output. The total output volume is set by the “FINAL VOLUME” knob.

Input Mode

Typically, the Modulator signal is derived from the Microphone input (MIC) i.e. 
whatever is plugged into the inputs “MIC Left” and “MIC Right” of the FBVC. However, 
the FBVC allows to load a mono or stereo WAV file which can be used as the Modulator 
signal instead. To select the input and/or a WAV file just click on the box right to the 
“INPUT” label under the block diagram.

Example menu entries for the Input mode.

When you select a WAV file, its playback will be triggered by the keyboard. In 
“Legato” mode, playback starts once for the first key you press and will restart only if 
all keys have been released. If “Legato” mode is deselected, playback restarts with 
each key you press.

Note that you can set the default path for your WAV files using the Options Menu.

Vocoder Mode

As stated already in the introductory section, the VC-10 had a minor design flaw (well, 
I am not sure if it really was a flaw!): The highest four bands of the Synthesis section 
are only fed with the Noise signal but not with the Tone Generator of external signal. 
Thus, only the first sixteen bands could really be used for the Tone Generator.
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The FBVC can fix this flaw by clicking the box right beneath the Input mode box. Here 
you can switch the Vocoder mode from “VC-10 Standard” to “VC-10 Full Bands”.

Switching the “Keyboard” On/Off

The “KBD” switch right to the Vocoder Mode box (not to be found on the real VC-10) 
can be used to switch the internal “keyboard” of. This means that incoming MIDI 
notes do not generate a sound. WAV playback however will still be triggered. The 
handiness of this switch will be clear once you really need it! ;-)

Advanced Operation
Now we are getting to the advanced operation modes of the FBVC – the tweaks! Click 
on the little at the lower right of the front panel and get ready.

Tweaking the Vocoder Bands

The trim pots in first row “ANALYSIS” can be used to set the center frequency of the 
20 analysis bandpass filters.

Note: Each bandpass of the FBVC consists of a series of two 2-pole bandpass filters with 
identical Q. The center frequency of the second filter is 0.829 times lower than the center 
frequency of the first filter. The frequency displayed in the FBVC is always the frequency of 
the first filter.

The trim pots in the second row “FILTER” control the center frequencies of the 
Synthesis filters while the trim pots of the third row “LEVEL” set their respective 
levels.

The switches of the fourth row determine if the aplitude of a Synthesis filter will be 
modulated (via a VCA) by the respective output of the Analysis filter or if it will remain 
fixed. This feature allows to turn the FBVC into a fixed filter bank!

The “TOOLS” buttons opens a menu with some little helpers to set the various vocoder 
band parameters (including reset to default).
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Bias, Limit, and Speed – Imperative Imperfection

Compared to the original VC-10 the FBVC sounds rather “clean” and “precise” because 
crucial parts of the VC-10 were analog circuitry having a rather limited working range. 
This was especially true for the 20 VCAs which controlled the filter band’s amplitude.

The level at which the VCAs started to operate could be set via a trimmer potentio-
meter at the back side of the VC-10. Normally this was done only once by the 
manufacturer but due to component aging etc. it would have been necessary to 
readjust this Bias. On the FBVC this trimmer is realized by the “BIAS” control on the 
tweak panel. Note that at a Bias level higher than 0 the FBVC produces a sound even 
if no Modulator signal is applied.

Another “problem” with the VCAs of the VC-10 was that at a certain level of the 
control input voltage the amplification of the respective VCA did not increase any more 
– the VCA control was “limited” to a maximum value. This behavior can be simulated 
with the “LIMIT” control: The higher the value of “LIMIT”, the more extreme is the 
simulated limiting effect.

Finally you can adjust the responsiveness of the VCAs i.e. the “speed” at which they 
react to changes of the control voltages. The respective control is called “SPEED”.

If you play with the “BIAS”, “LIMIT” and “SPEED” controls you will soon find a setting 
that closely simulates the “imperfect” sound of the real VC-10. For sound comparison 
I recommend the nice track “Guten Abend, Leute” by Dorothea Raukes (Deutsche 
Wertarbeit).

Tone Generator Envelope

The Tone Generator of the VC-10 provided just an organ-like envelope of the signal 
amplitudes – even simple string machines could do more! That’s why I added an 
“ATTACK” and “RELEASE” control to the FBVC. Note that the WAV playback is affected 
by this envelope too.

Ensemble

The original Ensemble effect earned a lot of criticism because its speed was fixed and 
to fast by default. Being controlled by two LFOs (a “slow” and a “fast” one) I decided 
to make their rates being set by dedicated controls (in fact four of them because the 
FBVC is stereo).

Control Operation

The Sound Manager

To select one of the 64 patches just click on the program number or the previous/next 
arrow buttons, and edit its name by clicking in the text field.



Full Bucket Vocoder FBVC Manual Page 10

MIDI Learn And The Configuration File “fbvc.ini”

Every parameter of the FBVC can be controlled by one MIDI controller. If you want to 
change the assignment of MIDI controller (CC; MIDI Control Change) to FBVC 
parameter the MIDI Learn function comes in quite handy: Just click the MIDI button 
on the Sound Manager panel (button turns yellow) and wiggle both the MIDI controller 
and the parameter you want to assign (you can abort LEARN by clicking the button 
again). If you want to unlearn the assignment, right-click the MIDI Learn button (the 
label now reads “UNLEARN”). Now wiggle the MIDI controller or the parameter that 
you want to unlearn. To save the controller assignments use “Save Configuration” in 
the Options menu (see next section); they are stored in the fbvc.ini configuration 
file. The exact location of this file depends on your operating system and will be 
displayed when you click on “Reload” or “Save Configuration”.

Options Menu

When clicking on the disk symbol of the File button, a context menu opens with the 
following options:

Copy Program Copy current program to internal clipboard

Paste Program Paste internal clipboard to current program

Load Program Load a program file containing a patch to the FBVC's 
current program

Save Program Save the FBVC's current program to a program file

Load Bank Load a bank file containing 64 patches into the FBVC

Save Bank Save the FBVC's 64 patches to a bank file

Init Program Initialize the current program

Default Path for 
Program Files

Sets the default path for program and bank files

Default Path for 
WAV Files

Sets the default path for WAV files when using the WAV 
playback option (see section Input Mode)

MIDI Thru Set globally if MIDI data sent to the FBVC should be sent 
through to its MIDI output (stored in configuration file)

Ignore Program 
Change

Set globally if MIDI Program Change data sent to the 
FBVC should be ignored (stored in configuration file)

Reload Configuration Reload the FBVC's configuration file

Save Configuration Save the FBVC's configuration file

Check Online for 
Update

When connected to the Internet, this function will check if 
a newer version of the FBVC is available at fullbucket.de

Visit fullbucket.de Open fullbucket.de in your standard browser
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Parameters

parameter ID description

Vocoder Mode 0 “VC-10 Standard” or “VC-10 Full Bands”

KBD Mode 1 Keyboard (Tone Generator) off/on

Input Mode 2 Selects signal input or WAV sample playback

Sample Legato 3 Legato WAV sample playback

Final Volume 4 Final output volume

Out Balance 5 Mix between input signal and Vocoder signal

Tune 6 Master tune of the Tone Generator

Velocity 7 Amount of velocity applied to the Tone Generator

Octave 8 Shifts the Tone Generator’s pitch one octave up

In Balance 9 Mix between Tone Generator and external input

Ext Level 10 Level of external signal input

Mic Level 11 Level of signal (Microphone) input

Accent Bend 12 Depth of Accent Bend applied to Tone Generator

Pitch Bend 13 Depth of Pitch Bend applied to Tone Generator

Vibrator Speed 14 Speed of the Vibrato effect

Vibrato Depth 15 Depth of the Vibrato effect

Ensemble 16 Ensemble effect off/on

Meter Mode 17 Select Carrier or Modulator signal for VU meter

Attack 18 Attack of Tone Generator envelope

Release 19 Release of Tone Generator envelope

Ensemble (L) Rate 1 20 Rate of first LFO of left Ensemble unit

Ensemble (L) Rate 2 21 Rate of second LFO of left Ensemble unit

Ensemble (R) Rate 1 22 Rate of first LFO of right Ensemble unit

Ensemble (R) Rate 2 23 Rate of second LFO of right Ensemble unit

Analysis Frequency 24–43 Center frequencies of the analysis filters

Synthesis Frequency 44–63 Center frequencies of the synthesis filters

Synthesis Frequency 64–83 Levels of the synthesis filters

Synthesis Fixed 84–103 Sets synthesis filter VCAs to modulated or fixed

Bias 104 Bias of the filter VCAs control

Limit 105 Limit (peak) of the filter VCAs control

Speed 106 Speed (responsiveness) of the filter VCAs control
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Frequently Asked Questions

How do I install the FBVC (Windows VST2 32 bit version)?
Just copy the files fbvc.dll from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST2 plug-in folder. Your DAW should automatically 
register the FBVC VST2 plug-in the next time you start it.

How do I install the FBVC (Windows VST2 64 bit version)?
Just copy the file fbvc64.dll from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST2 plug-in folder. Your DAW should automatically 
register the FBVC VST2 plug-in the next time you start it.

Note: You may have to remove any existing (32 bit) fbvc.dll from your VST2 plug-in 
folder or else your DAW may screw the versions up...

How do I install the FBVC (Windows VST3 64 bit version)?
Just copy the files fbvc.vst3 from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST3 plug-in folder. Your DAW should automatically 
register the FBVC VST3 plug-in the next time you start it.

How do I install the FBVC (Mac VST2/VST3/AU 64 bit)?
Locate the downloaded PKG package file fbvc_1_1_0_mac.pkg in Finder (!) and do a 
right- or control-click on it. In the context menu, click on “Open”. You will be asked if 
you really want to install the package because it comes from an “unidentified 
developer” (me ). Click “OK” and follow the installation instructions.

What is the plug-in ID of the FBVC?
The ID is f b v c .

How do I know if a new version of the FBVC is available?
When connected to the Internet, open the File menu (see section Options Menu) by 
clicking the disk icon and select the entry “Check Online for Updates”. If a new version 
of the FBVC is available on fullbucket.de the respective information will be shown in a 
message box.

The stock preset “XYZ (WAV play)” does not produce any 
sound!?
Copy the three WAV files that

• (Windows) come with the ZIP archive

• (Mac) are automatically installed under /Users/Shared/FullBucketMusic/

into your default WAV folder. You can set this folder using the Options Menu.
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